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BAB III 

METODOLOGI PENELITIAN 

 

 

 

A. Desain Penelitian 

Jenis penelitian yang digunakan adalah penelitian kuantitatif. Dalam 

penelitian ini, peneliti menggunakan pendekatan ex post facto karena pada 

penelitian ini, peneliti tidak memberikan perlakuan terhadap variabel yang 

diteliti. Peneliti menggunakan pendekatan ex post facto karena pendekatan 

ini bertujuan untuk menemukan penyebab yang memungkinkan perubahan 

perilaku, gejala dan fenomena yang disebabkan oleh suatu peristiwa, 

perilaku atau hal-hal yang menyebabkan perubahan pada variabel beba. 

Penelitian ini lebih cenderung mengandalkan data kuantitatif (Sugiyono 

(Hartono, 2017)).           

 

B. Variabel Penelitian 

Variabel penelitian yaitu segala sesuatu berbentuk apa saja yang ditetapkan 

oleh peneliti untuk dipelajari sehingga diperoleh informasi tentang hal 

tersebut, kemudian ditarik kesimpulannya (Sugiyono, 2018: 38). Variabel 

dalam Penelitian ini yaitu variabel bebas (independen variabel) dan variabel 

terikat (dependent variabel). 

1. Variabel bebas (independen variabel) 
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 Variabel bebas adalah variabel yang mempengaruhi atau yang menjadi 

sebab perubahannya atau timbulnya variabel dependen. Variabel bebas 

dalam penelitian ini yaitu pembelajaran online (X). 

2. Variabel terikat (dependent variabel) 

 Variabel terikat adalah variabel yang dipengaruhi atau yang menjadi 

akibat, karena adanya variabel bebas. Variabel terikat dalam penelitian 

yaitu kemampuan afektif (Y). 

 

 

 

Gambar 3.1 Skema Variabel Penelitian 

 

C. Definisi Operasional Variabel 

Adapun definisi opersional dalam penelitian ini adalah : 

1. Variabel bebas (X) pembelajaran online  

Pembelajaran online adalah pembelajaran yang diakses dengan cara 

belajar memalui komputer atau dengan jaringan internet ditempat 

mereka masing-masing tanpa harus mengikuti pelajaran secara tatap 

muka, pembelajaran daring bisa menggunakan aplikasi seperti 

Whatsapp Groub.  

2. Variabel Terikat (Y) Kemampuan afektif siswa 

Skor kemampuan afektif akan diperoleh setelah siswa mengisi angket. 

Bentuk pengukuran kemampuan afektif yang digunakan dalam 

penelitian ini adalah menerima dan menanggapi. Bentuk  tersebut akan 

Pembelajaran Online (X) Kemampuan afektif (Y) 
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digunakan sebagai kisi-kisi angket. Angket tersebut akan dibagikan 

kepada siswa, kemudian hasilnya dianalisis.  

 

D. Populasi dan Sampel 

1. Populasi  

Populasi adalah obyek atau subyek yang berada pada suatu wilayah dan 

memenuhi syarat-syarat terten tu berkaitan dengan masalah penelitian 

(Riduwan, 2016 : 8). Populasi dalam penelitian ini adalah seluruh siswa 

kelas IVdi SD Negeri 2 Purwodadi sebanyak 37 orang Tahun Ajaran 

2021/2022. 

Tabel 3.1 Data Jumlah Peserta Didik Kelas IV SD Negeri 2 Purwodadi 

No. 
Kelas Jumlah Peserta Didik 

1. A 17 

2 B 20 

  ∑ 37 

Sumber : Dokumentasi peserta didik kelas IV SD Negeri 2 Purwodadi 

 

2. Sampel 

Sampel adalah bagian dari populasi yang mempunyai ciri-ciri atau 

keadaan tertentu yang akan diteliti (Riduwan, 2016 : 10). Sampel dalam 

penelitian ini adalah kelas IV yang terdiri dari 2 kelas sebanyak 37 

siswa. Dalam penelitian ini, peneliti menggunakan teknik sampling 
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jenuh yaitu teknik populasi sampling atau yang menggunakan semua 

anggota populasi digunakan menjadi sampel (Riduwan, 2016: 21). 

Tabel 3.2 Jumlah Sampel 

No. 
Kelas Jumlah Peserta Didik 

1. A 17 

2 B 20 

∑ 37 

Sumber : Dokumen peserta didik kelas IV SD Negeri 2 Purwodadi 

 

E. Tempat dan Waktu Penelitian 

Penelitian akan dilaksanakan di SD Negeri 2 Purwodadi Kecamatan 

Adiluwih Kabupaten Pringsewu. Penelitian ini dilaksanakan pada semester 

genap tahun ajaran 2021/2022. 

 

F. Instrumen dan Metode Pengumpulan Data 

Instrumen pengumpulan data adalah alat bantu yang dipilih dan digunakan 

oleh peneliti dalam kegiatannya mengumpulkan agar kegiatan tersebut 

menjadi sistematis dan dipermudah olehnya Arikunto (Riduwan, 2016: 51). 

Metode pengumpulan data merupakan teknik atau cara-cara yang dapat 

digunakan oleh peneliti untuk mengumpulkan data. Metode (cara atau 

teknik) menunjuk suatu kata yang abstrak dan tidak diwujudkan dalam 

benda, tetapi hanya dapat dilihatkan penggunaannya melalui: angket, 



42 
 

wawancara, dokumentasi dan lainnya (Riduwan, 2016: 51). Untuk 

mengertahui pengaruh pembelajaran online terhadap minat belajar pada 

masa  pandemi di SD N 2 Purwodadi digunakan instrumen non tes. 

Instrumen non-tes yang digunakan adalah angket.  

Angket tersebut terdiri dari pertanyaan positif dan pertanyaan negatif. 

1. Angket ( Questionnaire) 

Angket (Questionnaire) adalah daftar pertanyaan yang diberikan 

kepada orang lain yang bersedia memberikan respon sesuai dengan 

permintaan pengguna. Tujuan penyebaran angket ini adalah mencari 

informasi yang lengkap mengenai suatu masalah dari responden tanpa 

merasa khawatir bila responden memberikan jawaban tidak sesuai 

dengan kenyataan dalam mengisi daftar pertanyaan. Angket yang 

digunakan dalam penelitian ini adalah angket tertutup dimana 

responden diminta memilih salah satu jawaban  dengan cara memberi 

tanda checklis (Riduwan, 2016: 52-53).   

Peneliti menyebarkan angket yang berisi masing-masing variabel 

(Pengaruh pembelajaran online tehadap kemampuan afektif di SD N 2 

Purwodadi), yang berisi 22 pertanyaan yang dijawab responden. 

Kuesioner/ angket diedarkan kepada siswa kelas IV dan akan langsung 

diisi saat itu juga. Hal ini bertujuan untuk menghindari kehilangan 

angket. Angket dibuat atas empat pilihan alternative jawaban yaitu : 
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Tabel  3.3 Skor untuk Setiap  Butir Pernyataan Pada Skala Likert 

Jawaban 
Skor Pernyataan 

Postif 

Skor Pernyataan 

Negatif 

Selalu (SL) 
4 1 

Sering (SR) 
3 2 

Kadang- Kadang (KD) 
 2 3 

Tidak Pernah (TP) 
1 4 

Sumber : (Sugiyono, 2018) 

 

Tabel 3.4 Kisi-kisi Angket Pembelajaran Online 

Variabel Indikator Positif 

 

Negatif 

 

Jumlah 

Item 

Pembelajaran 

Online 

 

 

 

Kemudahan dalam 

pembelajaran 

 

1, 2 

 

- 

 

 

8 
Fasilitas yang 

dibutuhkan 

 

3, 4 

 

- 

Akses internet  5 6 

Waktu dan tempat 7, 8 
- 
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Tabel 3.5 Kisi-kisi Kemampuan Afektif (Sikap) 

Variabel Aspek sikap Indikator Positif Negatif Jumlah 

Item 

Kemampuan 

Afektif 

(Sikap) 

Sikap jujur 

dalam 

mengerjakan 

tugas 

Melaksanakan 

tugas maupun 

pekerjaan 

dengan jujur 

seperti tidak 

menyalin 

jawaban dari 

teman maupun 

dari google 

(A3) 

 

 

 

9, 10 

 

 

 

11 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sikap disiplin 

dalam 

mengikuti 

proses 

pembelajaran 

selama 

pandemi 

Mematuhi tata 

tertib dan 

patuh pada 

ketentuan 

maupun aturan 

(A2) 

 

 

12, 13 

 

 

14 
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Sikap 

tanggung 

jawab dalam 

mengikuti 

proses 

pembelajaran 

Melaksanakan 

tanggung 

jawab dalam 

mengikuti 

proses 

pembelajaran 

secara online 

(A2) 

 

 

 

15 

 

 

 

 

 

16 

 

 

 

 

 

 

 

 

14 Sikap 

percaya diri 

dalam proses 

pembelajaran 

secara online 

Menanya 

tanpa ragu-

ragu (A1) 

 

 

17 

  

18 

 

 

- 

 

Sikap peduli 

terhadap 

teman 

Membantu 

teman yang 

kesulitan (A2) 

 

19, 20  

 

- 

Sikap 

menerima 

adanya 

pembelajaran 

online 

Menerima 

adanya 

pembelajaran 

online (A1) 

 

 

21, 22 

 

 

- 

Sumber : (Zuhri, 2020) 
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2. Dokumentasi 

Dokumentasi ditujukan untuk memperoleh data langsung dari tempat 

penelitian yang meliputi pembagian angket pembelajaran online dan 

angket kemampuan afektif pada masa pandemi, lokasi penelitian, 

struktur organisasi (Sugiyono, 2018 : 58). 

 

3. Observasi  

Observasi ini bertujuan untuk mengetahui pemahaman sikap dari 

masing-masing individu melalui pengamatan secara langsung. 

Berdasarkan pengamatan peneliti maka didapatkan hasil sebagai berikut 

berdasarkan kriteria penskoran. 

Tabel  3.6 Kriteria Skor 

Skor Keterangan 

1 Kurang 

2 Cukup 

3 Baik 

4 Sangat Baik 

Sumber : (Riduwan, 2016: 39) 

 

G. Metode Pengolahan dan Analisis Data 

1. Analisis Statistik Deskriptif 

Analisisis deskriptif adalah statistik yang digunakan untuk menganalisis 

data dengan cara mendeskripsikan atau menggambarkan data yang telah 
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terkumpul sebagaimana adanya tanpa bermaksud membuat kesimpulan 

yang berlaku untuk umum atau generalisasi (Sugiyono, 2018: 147). 

Pada penelitian ini, analisis deskriptif digunakan untuk menganalisis 

setiap perolehan skor dari masing-masing indikator dari setiap angket 

yang terdapat dalam variabel Pembelajaran online maupun kemampuan 

afektif siswa. Hasil dari setiap item pernyataan yang mewakili setiap 

indikator dalam angket penelitian kemudian dikonsultasikan dengan 

penafsiran menurut Riduwan (2013: 89) yang menggunakan kriteria 

antara lain sangat kuat, kuat, cukup, lemah, sangat lemah.  

 

2. Uji Instrumen 

a. Validitas 

Kegunaan Uji Pearson Product Moment atau analisis korelasi 

adalah mencari hubungan variabel bebas (X) dengan variabel 

terikat (Y) dan data berbentuk interval dan ratio. Uji ini lebih 

terkenal dengan analisis korelasi Pearson Product Moment 

(Riduwan, 2016: 227). 

 

  
                 

                            
 

 

Keterangan : 

r = Koefisien korelasi antara variabel X dan variabel Y  
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n = Jumlah sampel 

X = Skor tiap item 

Y = Skor seluruh item responden uji coba 

 

b. Analisis Reliabilitas 

Uji reliabilitas dilakukan untuk mengetahui tingkat keajekan atau 

ketepatan tes yang digunakan. Tes dikatakan reliabel yaitu jika soal 

tes tersebut memberikan hasil yang relatif sama (konsisten) 

walaupun soal tes tersebut diberikan pada subjek yang sama, 

meskipun soal tersebut diberikan kepada orang, waktu dan tempat 

yang berbeda. Sebagaimana diungkapkan oleh Sugiyono (2018: 

185) tahapan perhitungan uji reliabilitas dengan menggunakan 

teknik alpha cronbach, yaitu : 

1) Menentukan nilai varians setiap butir pertanyaan 

  
  

   
      

 

 
 

 

2) Menentukan nilai varians total 

  
  

        
 

 
 

 

3) Menentukan reliabilitas instrumen 
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Keterangan : 

            nilai reliabilitas 

             jumlah sample 

             jumlah butir soal 

  
             varian skor tiap soal 

  
          varian total 

        jumlah kuadrat data 

      = jumlah data dikuadratkan 

 

Selanjutnya nilai reliabilitas tes     dibandingkan dengan nilai table 

r product moment dengan       , taraf nyata 5% dengan 

kriteria: 

Jika            berarti reliabel. 

 

3. Uji Prasyarat Analisis 

Uji prasyarat analisis yang terdapat dalam penelitian ini yaitu uji 

normalitas data dan uji linieritas regresi. Adapun penjelasan lebih lanjut 

adalah sebagai berikut. 

a. Uji Normalitas Data 

Uji normalitas digunakan untuk mengetahui apakah data yang di 

analisis mempunyai sebaran (berdistribusi) normal atau tidak. Uji 

normalitas penelitian ini menggunakan bantuan program SPSS 22 
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One-Sample Kolmogorov-Smirnov Test untuk mengetahui apakah 

data yang diperoleh pada saat penelitian normal atau tidak.  

Adapun langkah-langkah yang dilakukan dalam mencari normalitas 

data melalui program IBM SPSS Statistics 22 yaitu klik Star > All 

Program > IBM SPSS Statistics 22 maka akan muncul halaman 

program SPSS 22. Selanjutnya, masukkan jumlah skor setiap siswa 

yang menjadi sampel yang diperoleh dari angket variabel X 

(pembelajaran online) dan Y (kemampuan afektif) pada kolom var. 

Langkah selanjutnya klik Variabel View pada kolom Name nomor 

1 isikan X dan nomor 2 isikan Y (sesuai dengan variabel). 

Kemudian ganti Desimals nomor 1 dan 2 menjadi 0, pada kolom 

Label isi nomor 1 dengan pembelajaran online dan nomor 2 diisi 

kemampuan afektif.  

Selanjutnya kembali ke Data View, sebelum kita mengetahui nilai 

signifikansi kita harus mencari nilai residual dari variabel 

pembelajaran online dan kemampuan afektif terlebih dahulu yaitu 

dengan cara klik menu Analyze > Regression > Linier kemudian 

pilih variabel pembelajaran online (X) pindahkan ke kolom 

Independent dan pilih variabel kemampuan afektif ke kolom 

Dependent >  Save>Unstandardized pada kolom Residuals > 

Continue > OK. Kemudian akan muncul output berupa tabel One-

Sample Kolmogorov- Smirnov Test.  
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Kaidah keputusan :  

1) Jika nilai signifikansi > 0,05 maka nilai residual berdistribusi 

normal. 

2) Jika nilai signifikansi < 0,05 maka nilai residual tidak 

berdistribusi normal. 

Hasil penelitian didapatkan data sampel variabel pembelajaran 

online dan kemampuan afektif memiliki nilai residual 0,200 > 0,05 

maka dapat disimpulkan bahwa nilai residual berdistribusi normal. 

 

b. Uji Linearitas 

Uji Lineartias bertujuan untuk mengetahui apakah dua variabel 

memiliki hubungan yang linear atau tidak. Peneliti menggunakan 

bantuan program IBM SPSS Statistics 22 untuk menguji linieritas 

data. Langkah-langkah yang ditempuh dalam melakukan uji 

linieritas data menggunakan program SPSS 22 adalah sebagai 

berikut : 

Klik Star > All Program > IBM SPSS Statistics 22 > maka akan 

muncul halaman program SPSS 22. Selanjutnya, masukkan jumlah 

skor setiap siswa yang menjadi sampel yang diperoleh dari angket 

variabel X (pembelajaran online) dan Y (kemampuan afektif) pada 

kolom var. Langkah selanjutnya klik Variabel View pada kolom 

Name nomor 1 isikan X dan nomor 2 isikan Y (sesuai dengan 

variabel). Kemudian ganti Desimals nomor 1 dan 2 menjadi 0, pada 
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kolom Label isi nomor 1 dengan pembelajaran online dan nomor 2 

diisi kemampuan afektif.  

Selanjutnya kembali ke Data View > Klik menu Analyze 

>Compare Mean > Means. Setelah itu muncul tampilan means > 

pilih variabel X (pembelajaran online) masukkan pada kolom 

Independent dan variabel Y (kemampuan afektif) pada kolom 

Dependent > Options > beri ceklis pada Test for Linearity > 

Continue > OK. Setelah itu akan muncul output berupa tabel 

Anova. 

Dasar pengambilan keputusan: 

1) Jika nilai sig. Deviation from liniearity > 0,05 maka terdapat 

hubungan yang linier antara variabel bebas dengan variabel 

terikat. 

2) Jika nilai sig. Deviation from liniearity < 0,05 maka tidak 

terdapat hubungan yang linier antara variabel bebas dengan 

variabel terikat. 

Hasil penelitian didapatkan data sampel variabel pembelajaran 

online dan kemampuan afektif memiliki nilai deviation from 

linearity 0,150  > 0,05 maka dapat disimpulkan bahwa terdapat 

hubungan yang linear antara variabel bebas dan variabel terikat. 
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4. Uji Hipotesis 

Uji hipotesis yang ada dalam penelitian ini yaitu analisis korelasi, 

analisis regresi sederhana, koefisien determinasi, dan uji signifikansi. 

a. Analisis Regresi Sederhana 

Teknik statistik untuk menguji hipotesis dalam penelitian ini 

menggunakan teknik regresi sederhana. ”Kegunaan regresi dalam 

penelitian salah satunya adalah untuk meramalkan atau 

memprediksi variabel terikat (Y) apabila variabel bebas diketahui” 

(Riduwan, 2016: 224). Peneliti menggunakan bantuan program 

IBM SPSS Statistics 22. Langkah-langkah yang ditempuh peneliti 

untuk memperoleh analisis regresi sederhana menggunakan SPSS 

22 adalah sebagai berikut : 

Klik Star > All Program > IBM SPSS Statistics 22 > maka akan 

muncul halaman program SPSS 22. Selanjutnya, masukkan jumlah 

skor setiap siswa yang menjadi sampel yang diperoleh dari angket 

variabel X (pembelajaran online) dan Y (kemampuan afektif) pada 

kolom var. Langkah selanjutnya klik Variabel View pada kolom 

Name nomor 1 isikan X dan nomor 2 isikan Y (sesuai dengan 

variabel). Kemudian ganti Desimals nomor 1 dan 2 menjadi 0, pada 

kolom Label isi nomor 1 dengan pembelajaran online dan nomor 2 

diisi kemampuan afektif.  

Selanjutnya kembali ke Data View > Klik menu Analyze > 

Regression > Linear. Setelah itu muncul tampilan Linear 
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Regression > pilih variabel X (pembelajaran online) masukkan 

pada kolom Independent dan variabel Y (kemampuan afektif) pada 

kolom Dependent > OK. Setelah itu akan muncul output berupa 

tabel anova. 

Dasar pengambilan keputusan : 

1) Jika nilai signifikansi < 0,05 artinya variabel X berpengaruh 

terhadap variabel Y. 

2) Jika nilai signifikansi > 0,05 artinya variabel X tidak 

berpengaruh terhadap variabel Y. 

Hasil penelitian didapatkan data nilai F hitung = 54.669 dengan 

tingkat signifikansi sebesar 0,000 < 0,05 maka dapat disimpulkan 

bahwa ada pengaruh variabel Pembelajaran Online (X) terhadap 

variabel Kemampuan Afektif (Y). 

 

b. Koefisiensi Determinasi 

Koefisien determinasi digunakan untuk menyatakan seberapa besar 

pengaruh variabel X terhadap variabel Y. Adapun rumus koefisien 

determinasi yaitu: 

K = r
2 

x 100% 

Dimana: 

KP = Besarnya koefisien penentu (determinan). 

r = Koefisien korelasi  

(Riduwan, 2016: 228). 
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H. Jalannya Penelitian 

Penelitian dilaksanakan dalam dua tahapan yakni prapenelitian dan 

pelaksanaan penelitian. Adapun langkah-langkah yang digunakan adalah 

sebagai berikut: 

1. Prapenelitian 

Kegiatan yang dilakukan pada prapenelitian sebagai berikut: 

a. Membuat surat izin penelitian pendahuluan ke sekolah. 

b. Mengadakan observasi ke sekolah tempat diadakannya penelitian, 

untuk mendapatkan informasi tentang keadaan kelas yang akan 

diteliti. 

c. Membuat dan menyusun instrumen penelitian. 

d. Membuat instrumen penelitian penelitian yaitu angket 

pembelajaran online kemudian, angket tanggapan mengenai 

kemampuan afektif. 

e. Menetapkan sampel penelitian. 

2. Pelaksanaan Penelitian 

Tahap pelaksanaan meliputi beberapa kegiatan yaitu: Memberikan 

angket pembelajaran online dan kemampuan afektif, kemudian 

mengobservasi jalannya pemberlakuan ini. 

3. Tahap Akhir 

Pada tahapan ini kegiatan yang akan dilakukan antara lain: 
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a. Mengolah data hasil angket tentang pembelajaran online serta 

kemampuan afektif siswa. 

b. Memberikan kesimpulan berdasarkan hasil yang diperoleh dari 

langkah-langkah menganalisis data. 

 


